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[bookmark: _Toc497475212][bookmark: _Toc512793660]ABSTRACT
Black holes seem to play a key role in the universe, powering a wide variety of phenomena, from X-ray binaries to active galactic nuclei. Black holes, an extreme consequence of the mathematics of General Relativity, have long been suspected of being the prime movers of quasars, which emit more energy than any other objects in the Universe. Black holes are a prediction of Einstein’s theory of gravity, foreshadowed by the work of Michell and later Laplace in the late 18th century. K. Schwarzschild discovered the simplest kind of black hole in the first solution of Einstein’s equations of General Relativity, and Oppenheimer was among the first to consider the possibility that black holes might actually form in nature. The subject gained life in the 1960s and 70s, when supermassive black holes were implicated as the powerhouses for quasars and stellar–mass black holes were touted as the engines for many galactic X–ray sources. In the last decade, we have progressed from seeking supermassive black holes in only the most energetic astrophysical contexts, to suspecting that they may be routinely present at the centers of galaxies. This present paper presents a theoretical way to analyze the effect of a Stellar Black Hole, on its host galaxies. A two-dimensional, mass dependent gravitational bodies will be brought in the vicinity of a stellar black hole and the effect on these bodies will be observed. Even though the possibility of such an event is formidable, it is essential to do these simulations to test the drive of humanity for deep space exploration. Recent evidence indicates that supermassive black holes, which are probably quasar remnants, reside at the centers of most galaxies. As our knowledge of the demographics of these relics of a violent earlier Universe improve, we see tantalizing clues that they participated intimately in the formation of galaxies and have strongly influenced their present–day structure.

Keywords: Universe, X-Ray, Black Holes, Stellar–Mass, Galaxies, Gravitational, General Relativity, Quasars, Astrophysical, Demographics.
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[bookmark: _Toc512793661]Chapter 1: Introduction
1.1 [bookmark: _Toc497398615][bookmark: _Toc497475214][bookmark: _Toc512793662]Origin of Theory on Black hole

Newton’s Law of Gravitation states that the escape velocity ʋ, from a distance r from the center of gravity of a heavy object with mass m, is given by 
	(1.1)
John Mitchell in 1783, inquired of himself what happens if a body with a large mass m is compressed so much that the escape velocity from its surface would exceed that of light, or, v > c? Are there bodies with a mass m and radius R such that? 
	(1.2)
Pierre Simon de Laplace in 1796, further investigated the path of a ray of light when travelling in the vicinity of such object? It was a general notion that light cannot escape to infinity. Owing to the wave nature of the light it was concluded that light might be able to travel to infinity. The formation process for the low mass Black Hole is not known, and also no scientific observation has ever been made, indicating the existence of a Black Hole having a mass lower than the “Chandrasekhar Limit”. This raises the question about the existence of lighter Black Holes anywhere in the universe. It is here that one could ponder about every one of those basic suppositions that underlie the hypothesis of quantum mechanics, which is the fundamental structure on which all nuclear and sub-nuclear procedures known give off an impression of being based. Quantum mechanics depends on the presumption that each physically permitted arrangement must be incorporated as partaking in a quantum procedure. Inability to consider would essentially prompt conflicting outcomes. Smaller than expected Black Holes are surely physically permitted, regardless of whether we don't know how they can be framed. They can be framed on a basic level.
 


1.2 [bookmark: _Toc497398616][bookmark: _Toc497475215][bookmark: _Toc512793663]Introduction to General Relativity
Numerous attempts have been made to bring down the complexity of the General Relativity to the non-experts in the field of Relativistic Mechanics. These can be traced to museum displays of rolling a ball around on a bended surface, to explanations that are numerically very overwhelming. It was famously stated by physicist John Wheeler, “Space tells matter how to move and matter tells space how to curve”. After demonstrating the deviation in the path of light in the vicinity of gravitational force of a comparatively lighter weight body, Albert Einstein in 1915, published his General Theory of Relativity. Solution to Einstein’s field equations describing the gravitational field of a point mass and a spherical mass was put forward by Karl Schwarzschild, only few months from the publication of General Theory of Relativity. A few months after Schwarzschild, Johannes Droste, a student of Hendrik Lorentz, independently gave the same solution for the point mass and wrote more extensively about its properties. This solution had an impossible to miss solution at what is currently called the Schwarzschild radius, where it ended up being singular, implying that a portion of the terms in the Einstein conditions wound up becoming infinite. The idea of this surface was not exactly comprehended at the time. In 1924, Arthur Eddington demonstrated that the singularity vanished after performing a change of co-ordinate system, despite the fact that it took until 1933 for Georges Lemaître to understand, that this implied the singularity at the Schwarzschild range was a non-physical co-ordinate system peculiarity.
Arthur Eddington did however remarked on the likelihood of a star with mass compacted to the Schwarzschild radius in a 1926 book, taking note of that Einstein's hypothesis enables us to discount excessively extensive densities for unmistakable stars like Betelgeuse in light of the fact that a star of 250 million km span couldn't in any way, shape or form have so high a thickness as the sun. Right off the bat, the power of attractive energy would be great to the point that light would be not able escape from it, the beams falling back to the star like a stone to the earth. Also, the red shift of the phantom lines would be great to the point that the range would be moved out of presence. Thirdly, the mass would create such a great amount of ebb and flow of the space-time metric that space would curve around the sun.
Subrahmanyan Chandrasekhar in 1931 calculated that a non-rotating body of electron-degenerate matter above a certain limiting mass has no stable solutions. Oppenheimer and his co-creators translated the peculiarity at the limit of the Schwarzschild radius as demonstrating this was the limit of a bubble in which time ceased. This is a substantial perspective for external observers, yet not for infalling eyewitnesses. On account of this property, the crumbled stars were called "solidified stars", on the grounds that an outside spectator would see the surface of the star solidified in time at the moment where its fall takes it to the Schwarzschild radius.
1.3 [bookmark: _Toc497398617][bookmark: _Toc497475216][bookmark: _Toc512793664]Properties and structure
According to the no-hair theorem, mass, charge, and angular momentum are the only three independent physical properties a black hole has once it achieves a stable condition after formation. Black holes having same values for these properties, or parameters, are indistinguishable according to classical (i.e. non-quantum) mechanics. The thing that makes these properties special is the fact that they are visible only from outside of a black hole. As a charged black hole repels other like charges just like any other charged object. Gravitational analog of Gauss's law can be used to find the total mass inside a sphere containing a black hole, the ADM mass, far away from the black hole. By using frame dragging of the gravitomagnetic field the angular momentum can be measured from a faraway distance from a black hole. This makes no observable difference between the gravitational field of such a black hole and that of any other spherical object of the same mass. The “sucking in everything” notion is applicable only inside the Black Hole’s horizon and not outside.
[image: ]
[bookmark: _Toc512793719]Figure 1 Structure of Black Hole.

1.4 [bookmark: _Toc497398618][bookmark: _Toc497475217][bookmark: _Toc512793665]Event Horizon[bookmark: _Toc497472975][bookmark: _Toc512793720]Figure 2 Far away from the black hole, a particle can move in any direction, as illustrated by the set of arrows. It is only restricted by the speed of light.

[image: https://upload.wikimedia.org/wikipedia/commons/thumb/5/55/BH-no-escape-1.svg/409px-BH-no-escape-1.svg.png]
[image: https://upload.wikimedia.org/wikipedia/commons/thumb/1/10/BH-no-escape-2.svg/409px-BH-no-escape-2.svg.png]
[bookmark: _Toc512793721]Figure 3 Closer to the black hole space time starts to deform. There are more paths towards black hole then paths moving away.

[image: https://upload.wikimedia.org/wikipedia/commons/thumb/8/87/BH-no-escape-3.svg/409px-BH-no-escape-3.svg.png]
[bookmark: _Toc512793722]Figure 4 Inside of the event horizon, all paths bring the particle closer to the center of the black hole. It is no longer possible for the particle to escape.
There are 3 parts of a simple Black Hole: 
Event Horizon – Also called the Schwarzschild radius and is the part that we see all. It would appear that a dark, circular surface with a sharp edge in space.
Interior Space – This is a muddled space where space and time can get horrendously damaged, packed, extended, and generally an awful place to movement through.
Singularity - That's the place that matter goes when it falls through the event horizon. It's located at the center of the black hole, and it has an enormous density. 
When they reach the singularity, they are crushed to infinite density and their mass is added to the total of the black hole. Before that happens, they will have been torn apart by the growing tidal forces in a process sometimes referred to as spaghettification or the "noodle effect".
1.5 [bookmark: _Toc497398620][bookmark: _Toc497475219][bookmark: _Toc512793666]Observational Evidence
By their exceptionally nature, black holes don't specifically transmit any electromagnetic radiation other than the theoretical Hawking radiation, so astrophysicists scanning for black holes should for the most part depend on aberrant perceptions. 

1.5.1 [bookmark: _Toc497398621][bookmark: _Toc497475220][bookmark: _Toc512793667]Detection of gravitational waves from merging black holes
On 14 September 2015, the LIGO gravitational wave observatory mentioned the first ever effective objective fact of gravitational waves. The signal was steady with hypothetical expectations for the gravitational waves created by the merging of two black holes: one with around 36 sun based masses, and the other around 29 sun oriented masses.

1.5.2 [bookmark: _Toc497398622][bookmark: _Toc497475221][bookmark: _Toc512793668]Proper motions of stars orbiting Sagittarius A*
The correct movements of stars close to the focal point of our own Milky Way give observational proof that these stars are circling a supermassive Black Hole. Since 1995, cosmologists have followed the movements of 90 stars circling an imperceptible object correspondent with the radio source Sagittarius A*. By fitting their movements to Keplerian circles, the cosmologists could surmise, in 1998, that a 2.6 million M☉ object must be contained in a volume with a range of 0.02 light-years to cause the movements of those stars.
[image: ]
[bookmark: _Toc512793723]Figure 5 Keplerian Circles
1.5.3 [bookmark: _Toc497398623][bookmark: _Toc497475222][bookmark: _Toc512793669]X-Ray Binaries

X-beam pairs are twofold star frameworks that emanate a dominant part of their radiation in the X-beam to some portion of the range. These X-beam discharges are for the most part thought to come about when one of the stars (conservative question) accumulates matter from another (standard) star. The nearness of a conventional star in such a framework gives an extraordinary chance to concentrate the focal protest and to decide whether it may be a black hole. 
		(1.3)





[bookmark: _Toc497398624][bookmark: _Toc497475223]

[bookmark: _Toc512793670]Chapter 2: Literature Review
2 [bookmark: _Toc497395500][bookmark: _Toc497395930][bookmark: _Toc497398096][bookmark: _Toc497398625][bookmark: _Toc497471850][bookmark: _Toc497471898][bookmark: _Toc497472925][bookmark: _Toc497473152][bookmark: _Toc497473209][bookmark: _Toc497473912][bookmark: _Toc497475180][bookmark: _Toc497475224][bookmark: _Toc497476329][bookmark: _Toc501015045][bookmark: _Toc501015414][bookmark: _Toc512536655][bookmark: _Toc512590715][bookmark: _Toc512590779][bookmark: _Toc512590876][bookmark: _Toc512591051][bookmark: _Toc512591113][bookmark: _Toc512600027][bookmark: _Toc512600091][bookmark: _Toc512789514][bookmark: _Toc512792668][bookmark: _Toc512792967][bookmark: _Toc512793037][bookmark: _Toc512793107][bookmark: _Toc512793171][bookmark: _Toc512793340][bookmark: _Toc512793531][bookmark: _Toc512793601][bookmark: _Toc512793671]
2.1 [bookmark: _Toc497475225][bookmark: _Toc512793672]Previously Published Black Holes Simulations
2.1.1 [bookmark: _Toc497475226][bookmark: _Toc512793673]The Black Hole Clustering Algorithm: A MATLAB Simulation

This source code was written for the first time in order to simulate the Meta-heuristic Black Hole Clustering Method. First idea of this simulation proposed by A.Hatamlou in 2013. It was analyzed that this simulated black hole clustering method is similar to the PSO clustering method. At the other hand, the Black Hole Optimization is in fact a simplified version of Particle Swarm Optimization with inertia weight. So, this Data Clustering version of the Black Hole Algorithm can be used by researchers to solve some complex problems. Its efficiency be able to reach to PSO and even more than it in some problems. 
2.2 [bookmark: _Toc497475227][bookmark: _Toc512793674]Black Hole Phenomenon
In the eighteens-century John Michell and Pierre Laplace were the pioneers to identify the concept of black holes. Integrating Newton’s law they formulated the theory of a star becoming invisible to the eye, however, during that period it was not known as a black hole and it was only in 1967 that John Wheeler the American physicist first named the phenomenon of mass collapsing as a black hole. A black hole in space is what forms when a star of massive size collapses. The gravitational power of the black hole is too high that even the light cannot escape from it. The gravity is so strong because matter has been squeezed into a tiny space. Anything that crosses the boundary of the black hole will be swallowed by it and vanish and nothing can get away from its enormous power. The sphere-shaped boundary of a black hole in space is known as the event horizon. The radius of the event horizon is termed as the Schwarzschild radius. At this radius, the escape speed is equal to the speed of light, and once light passes through, even it cannot escape. Nothing can escape from within the event horizon because nothing can go faster than light. The Schwarzschild radius is calculated by the following equation:

		(2.1)

where G is the gravitational constant, M is the mass of the black hole, and c is the speed of light. If anything moves close to the event horizon or crosses the Schwarzschild radius it will be absorbed into the black hole and permanently disappear. The existence of black holes can be discerned by its effect over the objects surrounding it.
2.3 [bookmark: _Toc497475228][bookmark: _Toc512793675]Creation of Black Holes.
Only stars with very large masses can become black holes. Our Sun, for example, is not massive enough to become a black hole. Four billion years from now when the Sun runs out of the available nuclear fuel in its core, our Sun will die a quiet death. Stars of this type end their history as white dwarf stars. More massive stars, such as those with masses of over 20 times our Sun’s mass, may explode as supernovae and eventually create a black hole.
A common type of black hole is produced by certain dying stars. A star with a mass greater than about 20 times the mass of our Sun may produce a black hole at the end of its life. The more massive the core of the star, the greater the force of gravity that compresses the material, collapsing it under its own weight.
2.4 [bookmark: _Toc497475229][bookmark: _Toc512793676]Types of Black Holes
[image: ]According to theory, there might be three types of black holes: stellar, supermassive, and miniature black holes – depending on their mass. These black holes would have formed in different ways. Stellar black holes form when a massive star collapses. Supermassive black holes, which can have a mass equivalent to billions of suns, likely exist in the centers of most galaxies, including our own galaxy, the Milky Way. We don't know exactly how supermassive black holes form, but it's likely that they're a byproduct of galaxy formation. Because of their location in the centers of galaxies, close to many tightly packed stars and gas clouds, supermassive black holes continue to grow on a steady diet of matter. [bookmark: _Toc512793724]Figure 6 Black Holes

No one has ever discovered a miniature black hole, which would have a mass much smaller than that of our Sun. But it's possible that miniature black holes could have formed shortly after the "Big Bang," which is thought to have started the universe 13.7 billion years ago. Very early in the life of the universe the rapid expansion of some matter might have compressed slower-moving matter enough to contract into black holes. Based on the particles contained inside the black holes, there are four types of Black Holes; [bookmark: _Toc497472978]Figure 6 Black Holes

Table 1 Quadrant for types of Black hole
	
	Non Rotating (J = 0)
	Rotating (J ≠ 0)

	Uncharged (Q = 0)
	Schwarzschild
	Kerr

	Charged (Q ≠ 0)
	Reissner - Nordstorm
	Kerr - Newmann


2.5 [bookmark: _Toc512793677]Black Hole near Galaxy Effects
2.5.1 [bookmark: _Toc512793678]Time Dilation

The modern theory of gravity, called the Theory of General Relativity, developed by Albert Einstein in 1915 leads to some very unusual predictions, which have all been verified by experiments.
One of the strangest ones is that two people will experience the passage of time very differently if one is standing on the surface of a planet, and the other one is in space. This is because the rate of time passing depends on the strength of the gravitational field that the observer is in.
		(2.2)
2.5.2 [bookmark: _Toc512793679]Tidal Forces due to Black Hole
[bookmark: _GoBack]
A tidal force is a difference in the strength of gravity between two points. The gravitational field of the Moon produces a tidal force across the diameter of Earth, which causes Earth to deform. It also raises tides of several meters in the solid Earth, and larger tides in the liquid oceans. If the tidal force is stronger than a body's cohesiveness, the body will be disrupted. The minimum distance that a satellite comes to a planet before it is shattered this way is called its Roche Distance.
		(2.3)
2.5.3 [bookmark: _Toc512793680]Temperature near Black Hole

When gas flows into a black hole, it gets very hot and emits light. The gas is heated because the atoms collide with each other as they fall into the black hole. Far away from the black hole, the atoms do not travel very fast so the gas is cool. But close to the black hole, the atoms can be moving at millions of kilometers/hour and the gas can be thousands of degrees hot!
	(2.4)
2.5.4 [bookmark: _Toc512793681][image: ]Brightness near the Black Hole
Figure 7 Object falling in the black hole
[bookmark: _Toc512793725]Figure 7 Object falling in Black Hole

When from a distance, not only does the passage of time slow down for someone falling into a black hole, but the image fades to black! This happens because, during the time that the object reaches the event horizon and passes beyond, a finite number of light particles (photons) will be emitted. Once these have been detected to make an image, there are no more left because the object is on the other side of the event horizon and the photons cannot escape. A star, collapsing to a black hole, will be going very fast as it collapses, then appear to slow down as time dilates.
	(2.5)


[bookmark: _Toc497398631][bookmark: _Toc497475230][bookmark: _Toc512793682]Chapter 3: Methodology
3 [bookmark: _Toc497395509][bookmark: _Toc497395937][bookmark: _Toc497398103][bookmark: _Toc497398632][bookmark: _Toc497471857][bookmark: _Toc497471905][bookmark: _Toc497472932][bookmark: _Toc497473159][bookmark: _Toc497473216][bookmark: _Toc497473919][bookmark: _Toc497475187][bookmark: _Toc497475231][bookmark: _Toc497476336][bookmark: _Toc501015057][bookmark: _Toc501015426][bookmark: _Toc512536667][bookmark: _Toc512590727][bookmark: _Toc512590791][bookmark: _Toc512590888][bookmark: _Toc512591063][bookmark: _Toc512591125][bookmark: _Toc512600039][bookmark: _Toc512600103][bookmark: _Toc512789526][bookmark: _Toc512792680][bookmark: _Toc512792979][bookmark: _Toc512793049][bookmark: _Toc512793119][bookmark: _Toc512793183][bookmark: _Toc512793352][bookmark: _Toc512793543][bookmark: _Toc512793613][bookmark: _Toc512793683]
3.1 [bookmark: _Toc497398633][bookmark: _Toc497475232][bookmark: _Toc512793684]Solar System Simulation in MATLAB

The model treats the sun and planets as perfect spheres each with three translational degrees of freedom. Planet spin is ignored. Gravitational fields generate the forces that keep the planets in orbit. 
3.1.1 [bookmark: _Toc497398634][bookmark: _Toc497475233][bookmark: _Toc512793685][image: ]Model Overview
[bookmark: _Toc512793726]Figure 8 Solid Block

Solid blocks represent the solar system bodies and provide their geometries, inertias, and colors.
[image: ]
Cartesian Joint blocks define the bodies’ degrees of freedom relative to the world frame, located at the solar system barycenter.[bookmark: _Toc512793727]Figure 9 Cartesian Joint Block flow


[image: ]Gravitational Field blocks add the long-range forces responsible for bending the initial planet trajectories into closed elliptical orbits.
[bookmark: _Toc512793728]Figure 10 Inserting Gravity

3.1.2 [bookmark: _Toc497398635][bookmark: _Toc497475234][bookmark: _Toc512793686]Initiation of Model A

Step 1	At the MATLAB command prompt, we enter smnew. A MATLAB opens a model template with commonly used blocks and suitable solver settings for Simscape Multibody models.
Step 2 	We cut all but the Mechanism Configuration, Solver Configuration, and World Frame blocks. These three blocks provide the model with gravity settings, solver settings, and a global inertia reference frame.
Step 3 	In the Mechanism Configuration block dialog box, we set the Uniform Gravity to NONE. This setting enables you to model gravity as an inverse-square law force using Gravitational Field blocks instead.
3.1.3 [bookmark: _Toc497398636][bookmark: _Toc497475235][bookmark: _Toc512793687]Addition of the Solar System Bodies

Step 1	In the Solid block dialog boxes, we set the Geometry > Shape parameter to Sphere and the Inertia > Based on parameter to Mass.
Step 2	We specify the following Solid block parameters in terms of MATLAB data structure fields. Enter the field names in the format Structure.Field, where Structure is the title-case name of the solar system body and Field is the string shown in the table—e.g., Sun.R or Earth.RGB
Step 3	In the Simulink® menu bar, we select Tools > Model Explorer > Model Workspace >  Data 
[image: ]
[bookmark: _Toc512793729]Figure 11Solar System Bodies
3.1.4 [bookmark: _Toc497398637][bookmark: _Toc497475236][bookmark: _Toc512793688]Addition of Degrees of Freedom

Step 1		We add to the model nine Cartesian Joint blocks from the Joints library.
Step 2		We connect and name the blocks as shown in the figure.
[image: ]
[bookmark: _Toc512793730]Figure 12 Adding Degree of Freedom
3.1.5 [bookmark: _Toc497398638][bookmark: _Toc497475237][bookmark: _Toc512793689]Addition of the Initial State Targets

Step 1 	In the Cartesian Joint block dialog boxes, we check the State Targets > Specify Position Target and State Targets > Specify Velocity Target checkboxes for the X, Y, and Z prismatic joint primitives.					
Step 2 	We specify the Cartesian Joint state target values for the X, Y, and Z prismatic joint primitives in terms of MATLAB structure fields. Also, the field names will be in the format Structure.Field, where Structure is the title-case name of the solar system body and Field is the string shown in the table—e.g., Sun.Px or Earth.Vz.
Step 3	Addition of the State Target Initialization Code. We add the State Target Initialization Code  >  Model Workspace  > Data Source to MATLAB Code. 
3.1.6 [bookmark: _Toc497398639][bookmark: _Toc497475238][bookmark: _Toc512793690]Addition of the Gravitational Fields

Step 1	In each Solid block dialog box, we expand the Frames area and click the Create button.
Step 2	We set the Frame Name parameter to R2 and click the Save button.		
Step 3	We Set the Frame Name parameter to R2 and click the Save button.
Step 4	In the Gravitational Field blocks, we specify the Mass parameter as MATLAB structure field names. The field names will be in the format Structure. Field, where Structure is the title-case name of the solar system body and Field is the string M—e.g., Sun.M or Earth.M. These fields have been previously defined in the model workspace.
[image: ]
[bookmark: _Toc512793731]Figure 13 Adding Gravitational Fields
3.1.7 [bookmark: _Toc497398640][bookmark: _Toc497475239][bookmark: _Toc512793691]Configuration and Initiation of the Simulator

We configure the Simulink solver settings to capture ten earth revolutions in a single simulation. Then, simulate the model and shows the resulting solar system animation. We configure the animation settings to play the ten-year animation in the period of a few seconds.
Step 1		In the Simulink menu bar, we select Simulation > Model Configuration Parameters.
Step 2	We set the Stop time parameter to 10*365*24*60*60. This number, equal to ten years in seconds, allows us to simulate a full ten earth revolutions from Nov 1st , 2017 through Nov 1st, 2027.
Step 3	We set the Max step size parameter to 24*60*60. This number, equal to one day in seconds, is small enough to provide smooth animation results. 
Step 4	We update the block diagram, for example, by selecting Simulation > Update Diagram.
Step 5	 	We run the simulation, for example, by selecting Simulation > Run.
Step 6	 	In Mechanics Explorer, select Tools > Animation Settings.
Step 7 	In Base (1X) Playback Speed, we enter 3153600. This speed corresponds to one earth revolution every ten seconds.
Step 8 	We can Pause and play the animation to apply the new base playback speed. The figure shows the animation results at the new speed.
3.2 [bookmark: _Toc497475240][bookmark: _Toc497398641][bookmark: _Toc512793692]Ephemeris Database for a particular time zone simulation

Ephemeris database provides the initial states—positions and velocities—of the sun and planets relative to the world frame. The initial states correspond to the solar system configuration on Nov 1st, 2017. These databases are the NASA Jet Propulsion Laboratory (JPL) databases for several planets in the solar system and other celestial-related data.
We obtained the ephemeris data using the MATLAB ‘planetEphemeris’ function after installing the Aerospace Ephemeris Data support package. 
Using the ‘aeroDataPackage’ function we can add extra packages and data in the Aerospace toolbox.
//syntax:
position= planetEphemeris(‘ephemerisTime’,’center’,’target’,’ephemerisModel’,’units’,’action’)
position= planetEphemeris(ephemerisTime,center,target) implements the position of the target object relative to the specified center object for a given Julian date ephemerisTime. By default, the function implements the position based on the DE405 ephemerides in units of km.
[position,velocity] = planetEphemeris(___) implements the position and velocity of a the target object relative to the specified centre for a given Julian date ephemerisTime using any of the input arguments in the previous syntaxes.
3.3 [bookmark: _Toc497475241][bookmark: _Toc512793693]Spiral Galaxy Formation Simulation Using MATLAB Function Blocks[29]

This model was inspired by the classic paper "Galactic Bridges and Tails". The original paper explained how disc shaped galaxies could develop spiral arms. Two-disc shape galaxies originally are far apart. They then fly by each other and almost collide. Once the galaxies are close enough, mutual gravitational forces cause spiral arms to form.
[image: ]
[bookmark: _Toc512793732]Figure 14 Matlab Simulation of 2 Spiral Galaxies
3.3.1 [bookmark: _Toc497398642][bookmark: _Toc497475242][bookmark: _Toc512793694]Initial Conditions
The initial conditions are: galaxy radius in parsecs (rp), galaxy mass in solar mass units (cm), galaxy position in parsecs (pos), and galaxy velocity in m/s (vel).In the model, constant blocks specify the initial conditions. The initial conditions have been chosen such that the galaxies will nearly collide at some point in time. 
3.3.2 [bookmark: _Toc497398643][bookmark: _Toc497475243][bookmark: _Toc512793695]Construct of Galaxy Blocks
The initial conditions are passed to the MATLAB function blocks Construct Galaxy 1 and Construct Galaxy 2. These MATLAB function blocks contain MATLAB code that builds the galaxy models.
In a typical galaxy, most of the mass is concentrated in its center as a super-massive black hole and/or star agglomeration. We model the galaxy as a disc with radius r with most of its mass concentrated in the inner circle of radius. In addition to this super-massive nucleus, the "ConstructGalaxy" MATLAB function block creates 349 random stars with masses ranging from 4 to 24 solar masses. These stars are randomly positioned within distance r/3 and r from the center of the galaxy. The stars initially move in circular orbits around the galaxy core. Every object (star or galaxy core) has mass, position (x, y, z), and velocity (Vx, Vy, Vz).

3.3.3 [bookmark: _Toc497398644][bookmark: _Toc497475244][bookmark: _Toc512793696]"Matrix Concatenation" Block.
This block joins information about both galaxies. At this point the model has 700 objects: 1 core for each galaxy and 349 stars around each core. These 700 objects interact according to Newtonian mechanics.

3.3.4 [bookmark: _Toc497398645][bookmark: _Toc497475245][bookmark: _Toc512793697]"Partition" Block.
This MATLAB function block separates all 700 objects into two groups: heavy bodies and light bodies. The heavy bodies are the galaxy cores. The light bodies are the stars. Because the galaxy cores are much heavier than individual stars, the model will consider only the heavy-heavy and heavy-light interactions. We can ignore the light-light body interactions. This will save a lot of time since 698 out of 700 bodies in the model are light.

3.3.5 [bookmark: _Toc497398646][bookmark: _Toc497475246][bookmark: _Toc512793698]"ApplyGravity" Block
This MATLAB function block uses Newtonian mechanics to compute the velocities and positions of the bodies at each step. The "combine" block is also a MATLAB function block. It merges the data about heavy and light objects together.

3.3.6 [bookmark: _Toc497398647][bookmark: _Toc497475247][bookmark: _Toc512793699]"PlotAll" Block
This MATLAB function block plots the bodies in a figure and updates the position of each star at every step in the simulation.
 	[image: ]
[bookmark: _Toc512793733]Figure 15 Final Model Obtained

3.4 [bookmark: _Toc512793700]Two Body Simulations having different mass
For studying the Black Hole and their Host Galaxies, We need to understand the behaviour of the masses in their gravitational field. We took different cases to observe the two bodies’ behavior in only their gravitational field.
3.4.1 [bookmark: _Toc512793701]Simulation Configuration 1 – Bodies at Rest
This Simulation is when the two bodies are in rest of equal masses with decent of time, in the gravitational pull, the approach themselves in a straight line. After the approach they collide and stay as a one mass.
This demonstrate the effect to equal mass still bodies’ gravitational field in a period of time. 
[image: ]
[bookmark: _Toc512793734]Figure 16 Two Body simulation of still masses
3.4.2 [bookmark: _Toc512793702]Simulation Configuration 2 – Bodies at rest – Mass varying
This simulation is for the two different masses with M2 be a higher mass this shows that the M1 has travelled more than the M2 due to net acceleration on M1 is more due to the factor of M2 which is very massive comparatively to the M1. Which give the accretion of M1 higher which makes the velocity of M1 higher hence M1 travels more.
[image: ]
[bookmark: _Toc512793735]Figure 17 Two Body Simulation with M1 greater than M2

3.4.3 [bookmark: _Toc512793703]Simulation Configuration 3 – Body 1 having velocity in x,y,z axis

[image: ]The study of two masses when one is at rest and other is having some velocity and also they are only in the effect of their gravitational field. The simulation result suggest that the both body come closer in the curved path due to velocity of particle in different direction as that of the gravitational force. This accelerates the bodies in different direction they trace the path that is curve and non-coplanar. Which also help us to understand why the bodies don’t submerge in black hole still it have height mass ratio.
[bookmark: _Toc512793736]Figure 18 Two Body Simulation with M1 having velocity and M2 is Still
3.4.4 [bookmark: _Toc512793704]Simulation Configuration 4 – Body 1 having velocity and mass varying
This simulation tells about the motion of the object when both bodies have velocity but the ratio of the masses are very high. It implies that the higher mass body will revolve but with lower speed comparative to light mass the distance travelled by the light mass would be large comparative to lighter mass but it also tell due to presence of the velocity the masses will not travel in the direction of the each other but they would  be forming curve. Due to acceleration due to gravitational pull.
[image: C:\Users\Siddharth\Pictures\Screenshots\Screenshot (247).png][bookmark: _Toc512793737]Figure 19 M1 being very heavy than M2

[image: C:\Users\Siddharth\Pictures\Screenshots\Screenshot (248).png]
[bookmark: _Toc512793738]Figure 20 Two Body simulation with mass varying with M1 having constant velocity
3.5 [bookmark: _Toc512793705]Galactic Black Hole without charge – Kerr Black Hole
As per the theory the Galaxy address Centre contain a massive black hole which binds the billions of star system in a Galaxy like sun in solar system. The effect of the black hole on the particle around a simulated and the following parameters are in consideration.
1. Radius of the orbit of celestial body
2. Spin rate of the black hole 
3. Polar angle of celestial body 
4. Polar angular momentum of body 
5. Angular momentum of the celestial body 
The types of Orbital simulated using mathematical 11.0.1 trial version they are as follows:
A. Close Orbit 
B. Constant radius Orbit 
C. Spiral capture Orbit 
D. Unstable circular orbit capture 
E. Unstable circular orbit escape 
F. Orbit reverse and capture 
G. Whirl Orbit
These are the possible orbits in which celestial bodies in the Galaxy can be found around black hole still with many assumptions when various radius from 2.1 to 38 AU. This defines the path of various solar system in the orbit around black hole and its effects on the trajectories. As well as the variation of angular momentum and the spin rate also define the path and ergo-sphere comes in the effect.
Ergo-sphere – The Region outside the rotating black hole’ outer event horizon. The region where the Black hole’s spin drags space in direction of the hole’s rotation so strongly that nothing can move counter clockwise to the spin of the black hole.

Table 2 Different types of obit with explanation for Galactic Kerr Black Hole
	Type of Orbit
	Angular Momentum
	Polar Angle of Celestial Body
	Polar Angular Momentum
	Spin Rate
	Radius of Orbit
	Remarks

	Constant Radius Orbit
	2
	
	0.76
	0.99
	4 AU
	In a Closed Orbit, the black hole forms and traces the curved cylinder with the time without colliding with the black hole.
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[bookmark: _Toc512793739]Figure 21 Constant Radius Orbit

	Closed Orbit
	2.148
	1.037
	0
	0.99
	4 AU
	This forms a closed loop ring

	[image: C:\Users\Siddharth\Pictures\Screenshots\Screenshot (240).png]
[bookmark: _Toc512793740]Figure 22 Closed Orbit

	Spiral Capture Black Hole
	3.45
	
	0
	0
	10 AU
	This forms a spiral capture orbit and gets inside the event horizon. This is the trajectory of the particles that are not binded in the black hole.

	[image: C:\Users\Siddharth\Pictures\Screenshots\Screenshot (241).png]
[bookmark: _Toc512793741]Figure 23 Spiral Capture Black Hole

	Unstable Circular orbit capture 
	3.999
	
	0
	0
	4 AU
	The body revolves in circle and degrade into circular orbit and lands on the black hole

	[image: ]
[bookmark: _Toc512793742]Figure 24 Unstable Circular Orbit Capture

	Unstable Circular Orbit Escape
	4
	
	0
	0
	4 AU
	It is the simualation of the orbit of the escape and the particles which is escaped from galaxy.

	[image: ]
[bookmark: _Toc512793743]Figure 25 Unstable Circular Orbit Escape

	Orbit reverse and capture 
	-4.5
	
	0
	0.9
	4 AU
	This is the orbit of the celestial body which passes through the ergosphere and get captured and the direction is reversed.

	[image: ]
[bookmark: _Toc512793744]Figure 26 Orbit Reverse and Capture

	Whirl Orbit
	1.0569
	
	2.89
	0.99
	10 AU
	This is the orbit of the particle that are in the random motion in the galaxy. It happens due to the spin rate of black hole and angular momentum of the particles.

	[image: ]
[bookmark: _Toc512793745]Figure 27 Whirl Orbit


3.6 [bookmark: _Toc512793706]Galactic Black Hole in 2 –D.
For getting and verifying the results we got from different simulation we did the 2d simulation of the body around the black hole. When we kept the body’s momentum constant and varied the mass of the black hole it demonstrated that the, orbit was capture orbit, i.e. degrading orbit around the black hole. But when we increased the momentum of the body the degrading orbit converted into circular stable orbit which proves the simulation we did before.
Hence this cross verified the effect of the black hole on the host galaxy shape and orbits of the star systems. 
[image: ]
[bookmark: _Toc512793746]Figure 28 Simulation of Galactic Black hole in 2D, simulating a point supposing a heavy star system or celestial body
The 2D simulation is nearly same as the 3d- simulation projection. And for the capture orbit at certain mass of the black hole the degrading orbit becomes the capture orbit. But when the mass is kept constant and the momentum were varied in different directions it was observed that the degrading orbit is converting into closed or constant radius orbit. Depending on the momentum given.
Which tell that the body with high angular momentum around black hole if the black hole is not massive enough would be revolving around the black hole unless the external parameters are changed.
3.7 [bookmark: _Toc512793707]Schwarzschild Black Hole Simulation
A black hole with zero charge Q = 0 and no angular momentum J = 0. The exterior solution for such a black hole is known as the Schwarzschild solution (or Schwarzschild metric), and is an exact unique solution to the Einstein field equations of general relativity for the general static isotropic metric (i.e., the most general metric tensor that can represent a static isotropic gravitational field),
[image: http://scienceworld.wolfram.com/physics/simg74.gif] 	(3.1)
The external Schwarzschild solution in Isotropic Eddington-Finkelstein coordinates is given by
[image: http://scienceworld.wolfram.com/physics/simg75.gif]		(3.2)
The Schwarzschild black hole metric then becomes
[image: http://scienceworld.wolfram.com/physics/simg76.gif][image: http://scienceworld.wolfram.com/physics/simg77.gif] 	(3.3)
For the time dilation we studied the orbit energy and applied the theory of relativity to the orbits of the Schwarzschild black hole. The obtained results at different values of the Angular momentum of the body and radius of the orbit, and the simulation calculation using - 
 	(3.4)
And,
 	(3.5)
And,
	(3.6)
After computing the results suggest that the time dilation with increase in angular momentum increases and as well as with increase in radius it decreases.
Hence we can conclude that the time dilation is proportional to the angular momentum and inversely proportional to the radius of the orbit.
[image: C:\Users\Siddharth\Pictures\Screenshots\Screenshot (243).png]
[bookmark: _Toc512793747]Figure 29 Time Dilation effect due to Schwarzschild Black Hole

[bookmark: _Toc512793708]Chapter 4: Result 
Simulation 1 – Two bodies at rest with respect to each other.
The Body follows straight line when placed in respective gravitational field. It implies that the attractive force is planar between two bodies.
Simulation 2 – Two bodies with dissimilar masses at rest with respect to each other.
It implies the acceleration of the body is inversely proportional to their inertial mass. Higher the mass less acceleration due to gravity.
Simulation 3 – Equal mass bodies moving relative to each other.
Equal Masses when placed, one at rest and other at motion. Due to gravitational attraction, planner force and the velocity makes the path curved.
Simulation 4 – Dissimilar massive bodies with one body moving with respect to the other.
Varying mass and one body with velocity, make the curve elongated as per the higher mass which tells the different orbits of the body around black hole.
Simulation 5 – Dissimilar massive bodies moving opposite to each other.
With constant masses and both body at motion tells the path traced by the star system around black hole and its influence in the period of revolution.
Simulation 6 – Constant radius of a body in vicinity of a 3-D Kerr Black Hole.
It tell when the body is in constant radius orbit with polar angular velocity at some polar angle the path around is forming bulged cylinder. Due to spin rate of the Black hole.
Simulation 7 – Closed orbit of a body in vicinity of a 3-D Kerr Black Hole.
In a closed orbit the path traced with zero polar angular moment but due to the spin rate of the black hole the path becomes cylinder.
Simulation 8 – Spiral capture orbit around a Kerr Black Hole.
When spin rate and polar angular momentum both are zero it becomes the spiral capture orbit, planar. But at large distance
Simulation 9 – Unstable circular capture orbit around a Kerr Black Hole.
When body comes loser after 4.4 Au it becomes the Circular capture orbit.
Simulation 10 – Escape orbit around a Kerr Black Hole.
When Black hole has spin rate and bodies’ angular momentum is negative the path becomes circular escape orbit.
Simulation 11 – Reverse and capture orbit around a Kerr Black Hole.
When the black hole is spinning and the body has negative angular momentum but when it comes in egrosphere it lands on black hole. Due to reversal of the orbits.
Simulation 12 – Whirl orbit around a Kerr Black Hole.
When body has positive angular momentum with positive polar angular momentum and spin rate of the black hole is also positive, the body whirl around black hole.
Simulation 13 - Time Dilation
We simulated Schwarzschild black hole to demonstrate time dilation which suggest that the time dilation is proportional to angular momentum of the body and inversely proportional to the radius of orbit. So nearer the body more would be time dilation.


[bookmark: _Toc512793709]Chapter 5: Conclusion
· Solar System simulation in MATLAB Simulink have shown positive results and the planets follow the numerically accepted Kepler’s Orbit. 
· Galaxy Simulation, consisting of a total of 700 bodies too have shown to follow the numerically accepted Kepler’s Orbit.
· Mathematica Simulations conducted on two body under the influence of each other’s gravity and also for 2D and 3D Kerr Black Hole with different celestial orbits.
· All simulations performed and done tells different relation of the blackhole on the galaxy. Which includes the different trajectories of the star systems and also the time dilation of the different orbit.
· It also tells that the spin rate of an black hole is an crucial thing to decide the shpe of the galaxy, with higher spin rate the galaxy would be hairly and so on.
· The body which is at less than 4.4 AU will lead to the capture orbit.
· The egrosphsere is one of the cruicial thing which decides the spin of the nesr galactic center bodies.
· Time Dilation is found to be for higher angular momentum of the body then that of the lower angular momentum body at the same orbit radius.


 
[bookmark: _Toc512793710]Appendix
[bookmark: _Toc512793711]Appendix A – Solar System
MATLAB CODE FOR CELESTIAL BODY PROPERTIES
% All values are in SI units.
% RGB color vectors are on a normalized 0-1 scale.
% Body dimensions are scaled for visualization purposes. 
% Scaling has no impact on model dynamics.

% Scaling
SunScaling = 0.5e2;
TerrestrialPlanetScaling = 1.2e3;
GasGiantScaling = 2.5e2;

% Sun
Sun.M = 1.99e30;
Sun.R = 6.96e8*SunScaling;
Sun.RGB = [1 0.5 0];

% Mercury
Mercury.M =3.30e23;
Mercury.R = 2.44e6*TerrestrialPlanetScaling;
Mercury.RGB = [0.5 0.5 0.5];

% Venus
Venus.M = 4.87e24;
Venus.R = 6.05e6*TerrestrialPlanetScaling;
Venus.RGB = [1 0.9 0];

% Earth
Earth.M = 5.97e24;
Earth.R = 6.05e6*TerrestrialPlanetScaling;
Earth.RGB = [0.3 0.6 0.8];
% Mars
Mars.M = 6.42e23;
Mars.R = 3.39e6*TerrestrialPlanetScaling;
Mars.RGB = [0.6 0.2 0.4];

% Jupiter
Jupiter.M = 1.90e27;
Jupiter.R = 6.99e7*GasGiantScaling;
Jupiter.RGB = [0.6 0 0.3];

% Saturn
Saturn.M = 5.68e26;
Saturn.R = 5.82e7*GasGiantScaling;
Saturn.RGB = [1 1 0];

% Uranus
Uranus.M = 8.68e25;
Uranus.R = 2.54e7*GasGiantScaling;
Uranus.RGB = [0.3 0.8 0.8];

% Neptune
Neptune.M = 1.02e26;
Neptune.R = 2.46e7*GasGiantScaling;
Neptune.RGB = [0.1 0.7 0.8];
MATLAB CODE TO INSERT INITIAL STATE TARGETS

SunScaling = 0.5e2;
TerrestrialPlanetScaling = 1.2e3;
GasGiantScaling = 2.5e2;
% Sun
Sun.M = 1.99e30;
Sun.R = 6.96e8*SunScaling;
Sun.RGB = [1 0.5 0];
Sun.Px = 5.5850e+08; 
Sun.Py = 5.5850e+08;
Sun.Pz = 5.5850e+08;
Sun.Vx = -1.4663;
Sun.Vy = 11.1238;
Sun.Vz = 4.8370;
% Mercury
Mercury.M =3.30e23;
Mercury.R = 2.44e6*TerrestrialPlanetScaling;
Mercury.RGB = [0.5 0.5 0.5];
Mercury.Px = 5.1979e+10; 
Mercury.Py = 7.6928e+09;
Mercury.Pz = -1.2845e+09;
Mercury.Vx = -1.5205e+04;
Mercury.Vy = 4.4189e+04;
Mercury.Vz = 2.5180e+04;

% Venus
Venus.M = 4.87e24;
Venus.R = 6.05e6*TerrestrialPlanetScaling;
Venus.RGB = [1 0.9 0];
Venus.Px = -1.5041e+10; 
Venus.Py = 9.7080e+10;
Venus.Pz = 4.4635e+10;
Venus.Vx = -3.4770e+04;
Venus.Vy = -5.5933e+03;
Venus.Vz = -316.8994;
% Earth
Earth.M = 5.97e24;
Earth.R = 6.05e6*TerrestrialPlanetScaling;
Earth.RGB = [0.3 0.6 0.8];
Earth.Px = -1.1506e+09; 
Earth.Py = -1.3910e+11;
Earth.Pz = -6.0330e+10;
Earth.Vx = 2.9288e+04;
Earth.Vy = -398.5759;
Earth.Vz = -172.5873;

% Mars
Mars.M = 6.42e23;
Mars.R = 3.39e6*TerrestrialPlanetScaling;
Mars.RGB = [0.6 0.2 0.4];
Mars.Px = -4.8883e+10; 
Mars.Py = -1.9686e+11;
Mars.Pz = -8.8994e+10;
Mars.Vx = 2.4533e+04;
Mars.Vy = -2.7622e+03;
Mars.Vz = -1.9295e+03;

% Jupiter
Jupiter.M = 1.90e27;
Jupiter.R = 6.99e7*GasGiantScaling;
Jupiter.RGB = [0.6 0 0.3];
Jupiter.Px = -8.1142e+11; 
Jupiter.Py = 4.5462e+10;
Jupiter.Pz = 3.9229e+10;
Jupiter.Vx = -1.0724e+03;
Jupiter.Vy = -1.1422e+04;
Jupiter.Vz = -4.8696e+03;

% Saturn
Saturn.M = 5.68e26;
Saturn.R = 5.82e7*GasGiantScaling;
Saturn.RGB = [1 1 0];
Saturn.Px = -4.2780e+11; 
Saturn.Py = -1.3353e+12;
Saturn.Pz = -5.3311e+11;
Saturn.Vx = 8.7288e+03;
Saturn.Vy = -2.4369e+03;
Saturn.Vz = -1.3824e+03;

% Uranus
Uranus.M = 8.68e25;
Uranus.R = 2.54e7*GasGiantScaling;
Uranus.RGB = [0.3 0.8 0.8];
Uranus.Px = 2.7878e+12; 
Uranus.Py = 9.9509e+11;
Uranus.Pz = 3.9639e+08;
Uranus.Vx = -2.4913e+03;
Uranus.Vy = 5.5197e+03;
Uranus.Vz = 2.4527e+03;

% Neptune
Neptune.M = 1.02e26;
Neptune.R = 2.46e7*GasGiantScaling;
Neptune.RGB = [0.1 0.7 0.8];
Neptune.Px = 4.2097e+12; 
Neptune.Py = -1.3834e+12;
Neptune.Pz = -6.7105e+11;
Neptune.Vx = 1.8271e+03;
Neptune.Vy = 4.7731e+03;
Neptune.Vz = 1.9082e+03;

MATLAB CODE TO SIMULATE REAL TIME DATA

%Implement the position of the Earth with respect to the Barycentre of solar system for Nov 1st, 2017:
position = planetEphemeris(juliandate(2017,11,1),'solarSystem','Earth')
output: 
position =
   1.0e+08 *
    1.1650    0.8564    0.3710
%position and velocity of earth with respect to barycentre of Solar System. 
[position,velocity]=planetEphemeris(juliandate(2017,11,1),'solarSystem','Earth')
position =
   1.0e+08 *
    1.1650    0.8564    0.3710
velocity =
  -19.0436   21.2804    9.2264



[bookmark: _Toc512793712]Appendix B – Galaxy Simulation
CODE FOR GALAXY 1

function bodies = ConstructGalaxy(rp,cm,pos,vel)
 
persistent bs;
numberOfBodies = 350;
 
if isempty(bs);
    rng('default');
    bs = ConstructGalaxy0(rp,cm,pos,vel,numberOfBodies);
end
 
bodies = bs;
 
function bodies = ConstructGalaxy0(rp,cm,pos,vel,n)
 
SolarMass = 1.9891e+30; % In kg
G = 6.672E-11; % Nm^2/kg^2 (Gravitational constant)
SpeedOfLight = 299792458; % in m/s
YearInSeconds = 365*24*60*60;
LightYear = SpeedOfLight*YearInSeconds;
Parsec = 3.26*LightYear;
 
radiusOuter = rp*Parsec;
radiusInner = (rp/3)*Parsec;
 
% Each star has X,Y,Z,VX,VY,VZ
% X,Y,Z position in cartesian coordinates
% VX,VY,VZ velocity in cartesian coordinates
cm = cm*SolarMass;
 
bodies = zeros(n,8);
bodies(1,1) = cm;
bodies(1,2) = pos(1)*Parsec;
bodies(1,3) = pos(2)*Parsec;
bodies(1,4) = pos(3)*Parsec;
bodies(1,5) = vel(1);
bodies(1,6) = vel(2);
bodies(1,7) = vel(3);
bodies(1,8) = 'r';
 
if n > 1
    for i = 2:n,
        m0 = rand*20+4;
        m = m0*SolarMass;
        r = rand*(radiusOuter - radiusInner) + radiusInner;
        arg = rand*(2*pi);
        x = r*cos(arg);
        y = r*sin(arg);
        z = 0;
        dx = cos(arg+pi/2);
        dy = sin(arg+pi/2);
        dz = 0;
        % Compute free fall velocity
        v = sqrt(G*cm/r);
        bodies(i,1) = m;
        bodies(i,2) = x+pos(1)*Parsec;
        bodies(i,3) = y+pos(2)*Parsec;
        bodies(i,4) = z+pos(3)*Parsec;
        bodies(i,5) = dx*v+vel(1);
        bodies(i,6) = dy*v+vel(2);
        bodies(i,7) = dz*v+vel(3);
        bodies(i,8) = 'r';
    end
end

CODE FOR GALAXY 2

function bodies = ConstructGalaxy(rp,cm,pos,vel)
 
persistent bs;
numberOfBodies = 350;
 
if isempty(bs);
    rng('default');
    bs = ConstructGalaxy0(rp,cm,pos,vel,numberOfBodies);
end
 
bodies = bs;
 
function bodies = ConstructGalaxy0(rp,cm,pos,vel,n)
 
SolarMass = 1.9891e+30; % In kg
G = 6.672E-11; % Nm^2/kg^2 (Gravitational constant)
SpeedOfLight = 299792458; % in m/s
YearInSeconds = 365*24*60*60;
LightYear = SpeedOfLight*YearInSeconds;
Parsec = 3.26*LightYear;
 
radiusOuter = rp*Parsec;
radiusInner = (rp/3)*Parsec;
 
% Each star has X,Y,Z,VX,VY,VZ
% X,Y,Z position in certesian coordinates
% VX,VY,VZ velocity in certesian coordinates
cm = cm*SolarMass;
 
bodies = zeros(n,8);
bodies(1,1) = cm;
bodies(1,2) = pos(1)*Parsec;
bodies(1,3) = pos(2)*Parsec;
bodies(1,4) = pos(3)*Parsec;
bodies(1,5) = vel(1);
bodies(1,6) = vel(2);
bodies(1,7) = vel(3);
bodies(1,8) = 'y';
 
if n > 1
    for i = 2:n,
        m0 = rand*20+4;
        m = m0*SolarMass;
        r = rand*(radiusOuter - radiusInner) + radiusInner;
        arg = rand*(2*pi);
        x = r*cos(arg);
        y = r*sin(arg);
        z = 0;
        dx = cos(arg+pi/2);
        dy = sin(arg+pi/2);
        dz = 0;
        % Compute free fall velocity
        v = sqrt(G*cm/r);
        bodies(i,1) = m;
        bodies(i,2) = x+pos(1)*Parsec;
        bodies(i,3) = y+pos(2)*Parsec;
        bodies(i,4) = z+pos(3)*Parsec;
        bodies(i,5) = dx*v+vel(1);
        bodies(i,6) = dy*v+vel(2);
        bodies(i,7) = dz*v+vel(3);
        bodies(i,8) = 'y';
    end
end

Code for partition block:
function [heavy,light] = Partition(bodies)
 
SolarMass = 1.9891e+30; % kg
Limit = 100*SolarMass;
 
n = size(bodies,1);
props = size(bodies,2);
heavy = zeros(n,props);
light = zeros(n,props);
 
lightIndex = 1;
heavyIndex = 1;
 
for i = 1:n
    m = bodies(i,1);
    if m < Limit
        light(lightIndex,:) = bodies(i,:);
        lightIndex = lightIndex + 1;
    else
        heavy(heavyIndex,:) = bodies(i,:);
        heavyIndex = heavyIndex + 1;
    end
end

Code for Gravity Block
function [heavy1,light1] = ApplyGravity(light,heavy)
 
G = 6.672E-11; % Nm^2/kg^2 (Gravitational constant)
 
YearInSeconds = 365*24*60*60;
timeStep = 2000000*YearInSeconds;
 
n = size(heavy,1);
 
heavy1 = heavy;
light1 = light;
 
for i = 1:n,
    mi = heavy(i,1);
    if mi == 0
        break;
    end
    xi = heavy(i,2);
    yi = heavy(i,3);
    zi = heavy(i,4);
    ar = [0 0 0];
    for j = 1:n,
        if i ~= j,
            mj = heavy(j,1);
            if mj == 0
                break;
            end
            xj = heavy(j,2);
            yj = heavy(j,3);
            zj = heavy(j,4);
            d = [xj yj zj] - [xi yi zi];
            dr2 = d(1)*d(1)+d(2)*d(2)+d(3)*d(3);
            ar = ar + (d/sqrt(dr2))*((G*mj)/dr2);
        end
    end
    for k = 1:3
        heavy1(i,4+k) = heavy(i,4+k) + ar(k)*timeStep;
    end
end
 
for i = 1:n,
    mi = light(i,1);
    if mi == 0
        break;
    end
    xi = light(i,2);
    yi = light(i,3);
    zi = light(i,4);
    ar = [0 0 0];
    for j = 1:n,
        mj = heavy(j,1);
        if mj == 0
            break;
        end
        xj = heavy(j,2);
        yj = heavy(j,3);
        zj = heavy(j,4);
        d = [xj yj zj] - [xi yi zi];
        dr2 = d(1)*d(1)+ d(2)*d(2) + d(3)*d(3);
        ar = ar + (d/sqrt(dr2))*((G*mj)/dr2);
    end
    for k = 1:3
        light1(i,4+k) = light(i,4+k) + ar(k)*timeStep;
    end
end
 
for i = 1:n
    for k = 1:3
        heavy1(i,k+1) = heavy1(i,k+1) + timeStep*heavy1(i,k+4);
    end
    for k = 1:3
        light1(i,k+1) = light1(i,k+1) + timeStep*light1(i,k+4);
    end
end

Code for Merge Block
function M = combine(A,B)
 
n = size(A,1);
nProps = size(A,2);
M = zeros(n,nProps);
for i = 1:n
    if A(i,1) == 0
        break
    end
    M(i,:) = A(i,:);
end
n1 = n - i + 1;
for j = 1:n1
    M(j+i-1,:) = B(j,:);
    if B(i,1) == 0
        break
    end
end

Code for Plot Block

function PlotAll(bodies)
 
persistent fig;
persistent oldPlot;
 
coder.extrinsic('findobj','get','set','figure','clf','hold','text','delete','plot3','drawnow');
 
n = size(bodies,1);
 
SpeedOfLight = 299792458; % in m/s
YearInSeconds = 365*24*60*60;
LightYear = SpeedOfLight*YearInSeconds;
Parsec = 3.26*LightYear;
foundFig = findobj('Tag','galaxyScreen');
 
if isempty(fig)||isempty(foundFig)
    if isempty(foundFig)
        fig = figure;
    else
        fig = figure(foundFig);
    end;
    clf(fig);
    set(fig, 'Name', 'Galaxy');
    set(fig, 'Tag', 'galaxyScreen');
    set(fig, 'Renderer', 'painters');
    set(fig, 'Color', 'black');
    hold('on');
    fig_axes = get(fig, 'CurrentAxes');
    init_axes(fig_axes);
    text(0,3.5*30000*Parsec,0,...
        ['Spiral galaxy formation on close encounters', ...
        char(10),'(based on Toomre & Toomre, 1972)'],...
        'Color','green','FontSize',12, 'HorizontalAlignment','center');
end
 
points_x = zeros(1,n);
points_y = zeros(1,n);
points_z = zeros(1,n);
points_col = zeros(1,n);
for i = 1:n,
    points_x(i) = bodies(i,2);
    points_y(i) = bodies(i,3);
    points_z(i) = bodies(i,4);
    points_col(i) = bodies(i,8);
end
 
%
% Remove the old plot.
%
if isempty(oldPlot)
    oldPlot = fig;
elseif ~isempty(foundFig)
    delete(oldPlot);
end
 
oldPlot = plot3(points_x,points_y,points_z,'w.');
drawnow;
 
function init_axes(a)
 
coder.extrinsic('set');
 
SpeedOfLight = 299792458; % in m/s
YearInSeconds = 365*24*60*60;
LightYear = SpeedOfLight*YearInSeconds;
Parsec = 3.26*LightYear;
set(a, 'CameraTarget', [0,0,0] );
set(a, 'CameraPosition', [0,22000*Parsec*3,18000*Parsec*3]);
set(a, 'CameraViewAngle', 80 );
set(a, 'CameraUpVector', [0,1,0]);
set(a, 'Visible', 'off' );
set(a, 'XLim', [-25000*Parsec*8,30000*Parsec*8]);
set(a, 'YLim', [-25000*Parsec*8,30000*Parsec*8]);
set(a, 'ZLim', [-30000*Parsec*8,30000*Parsec*8]);
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G = 667384/10^16; (* Gravitational Constant *)
Au = 149597870690; (* Astronomical Unit in m *)
mSol = 1988*10^27; (* Sun Mass in kg *)
(* Container *)
Funktion[{{x1x_, y1y_, z1z_}, {x2x_, y2y_, z2z_}}, {{vx1x_, vy1y_, 
    vz1z_}, {vx2x_, vy2y_, vz2z_}}, {m1_, m2_}, T_, 
  plotType : ("x" | "v"), plotOptions___] := 
 Module[{nds, Tmax, funcToPlot},
   (* Differential Equation *)
   nds = NDSolve[{
      x1'[t] == vx1[t], y1'[t] == vy1[t], z1'[t] == vz1[t],
      x2'[t] == vx2[t], y2'[t] == vy2[t], z2'[t] == vz2[t],
       vx1'[t] == (G  m2 (x2[t] - x1[t]))/
       Sqrt[((x2[t] - x1[t])^2 + (y2[t] - y1[t])^2 + (z2[t] - 
           z1[t])^2)^3],
             vy1'[t] == (G  m2 (y2[t] - y1[t]))/
       Sqrt[((x2[t] - x1[t])^2 + (y2[t] - y1[t])^2 + (z2[t] - 
           z1[t])^2)^3],
             vz1'[t] == (G m2 (z2[t] - z1[t]))/
       Sqrt[((x2[t] - x1[t])^2 + (y2[t] - y1[t])^2 + (z2[t] - 
           z1[t])^2)^3],
            vx2'[t] == (G m1  (x1[t] - x2[t]))/
       Sqrt[((x1[t] - x2[t])^2 + (y1[t] - y2[t])^2 + (z1[t] - 
           z2[t])^2)^3],
       vy2'[t] == (G m1  (y1[t] - y2[t]))/
       Sqrt[((x1[t] - x2[t])^2 + (y1[t] - y2[t])^2 + (z1[t] - 
           z2[t])^2)^3],
         vz2'[t] == (G m1  (z1[t] - z2[t]))/
       Sqrt[((x2[t] - x1[t])^2 + (y2[t] - y1[t])^2 + (z2[t] - 
           z1[t])^2)^3],
            x1[0] == x1x, y1[0] == y1y, z1[0] == z1z,
      x2[0] == x2x, y2[0] == y2y, z2[0] == z2z,
            vx1[0] == vx1x, vy1[0] == vy1y, vz1[0] == vz1z,
      vx2[0] == vx2x, vy2[0] == vy2y, vz2[0] == vz2z},
          {x1, x2, y1, y2, z1, z2,
      vx1, vx2, vy1, vy2, vz1, vz2},
     {t, 0, T}];
      If[Head[nds] =!= NDSolve, Tmax = nds[[1, 1, 2, 1, 1, 2]];
        funcToPlot = 
     If[plotType === 
        "x", {{x1[t], y1[t], z1[t]}, {x2[t], y2[t], z2[t]}}, {{vx1[t],
          vy1[t], vz1[t]}, {vx2[t], vy2[t], vz2[t]}}] /. nds[[1]];
        (* Plot Specifications *)
        ParametricPlot3D[Evaluate[funcToPlot], {t, 0, Tmax}, 
     PlotStyle -> {{Red, Thick}, {Blue, Thick}},
          (* Plot Range *)
     PlotRange -> {{-2 Au, 2 Au}, {-2 Au, 2 Au}}, AspectRatio -> 1, 
     MaxRecursion -> ControlActive[3, 100], plotOptions], 
    Text["Yukterez Mod."]]] // Quiet
Manipulate[Show[Funktion[
   (* Positions xyz *) {{P1x, P1y, P1z}, {P2x, P2y, P2z}},
   (* Velocities xyz *) {{v1x, v1y, v1z}, {v2x, v2y, v2z}},
   (* Masses *) {M1, M2},
   (* Plot Variables  *) T, xv,
   ImageSize -> {440, 440}],
    (* Initial Positions *)
  Graphics3D[{{Red, Point[{P1x, P1y, P1z}]}, {Blue, 
     Point[{P2x, P2y, P2z}]}}]],
 {{xv, "x", "Position"},
  {"x" -> "Position"}},
  (* Starttime and Timeinterval *)
 {{T, 3*^6, "Time"}, 10000, 2*10^7}, 
 {{M1, mSol}, 1, 4 mSol}, {{M2, mSol}, 1, 2 mSol}, 
 {{P1x, -Au}, -2 Au, 2 Au}, {{P1y, 0}, -2 Au, 
  2 Au}, {{P1z, -Au}, -2 Au, 2 Au},  
 {{P2x, Au}, -2 Au, 2 Au}, {{P2y, 0}, -2 Au, 2 Au}, {{P2z, Au}, -2 Au,
   2 Au}, 
 {{v1x, 0}, -100000, 100000}, {{v1y, 0}, -100000, 
  100000}, {{v1z, 0}, -100000, 100000},   
 {{v2x, 0}, -100000, 100000}, {{v2y, 0}, -100000, 
  100000}, {{v2z, 0}, -100000, 100000},  
  ControlPlacement -> {Right}]
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Manipulate[
 If[
  ! slidersEnabled,
      {pT, aI, rI, iL, \[Theta]I, p\[Theta]I, frame, tailLength, 
    zoomManual} = presetValues;
    slidersEnabled = True;
     ];
 viewRadius = 10;   
  view\[Theta]       = 0.85  \[Pi]/2;
 view\[Phi]       = 0.35   \[Pi]/2;
 divergence = 0.05 \[Pi]/2;
  rightViewPoint = 
    viewRadius {
    Sin[view\[Theta]] Cos[view\[Phi]],
    Sin[view\[Theta]] Sin[view\[Phi]],
    Cos[view\[Theta]]
              };
  leftViewPoint = 
    viewRadius {
    Sin[view\[Theta]] Cos[view\[Phi] - divergence],
    Sin[view\[Theta]] Sin[view\[Phi] - divergence],
    Cos[view\[Theta]]
              };
  Ee =
  \[ScriptCapitalE] /.
   Solve[
             ( -aI^2 p\[Theta]I^2 + 2 iL^2 rI +
        2 p\[Theta]I^2 rI - aI^2 rI^2 -
        iL^2 rI^2 - p\[Theta]I^2 rI^2 +
        2 rI^3 - rI^4 -
        4 aI iL rI \[ScriptCapitalE] + 2 aI^2 rI \[ScriptCapitalE]^2 +
        aI^2 rI^2 \[ScriptCapitalE]^2 + rI^4 \[ScriptCapitalE]^2 +
        aI^2 (aI^2 + (-2 + 
              rI) rI) (-1 + \[ScriptCapitalE]^2) Cos[\[Theta]I]^2 -
        iL^2 (aI^2 + (-2 + rI) rI) Cot[\[Theta]I]^2) == 0,
           \[ScriptCapitalE]
          ][[2]]; 
 Ce =
  p\[Theta]I^2 + 
   Cos[\[Theta]I]^2 (aI^2 (1 - Ee^2) + iL^2/Sin[\[Theta]I]^2);
 dynamicEquations =
  {
   r'[\[Tau]]   ==  (pr[\[Tau]] (a^2 - 2 r[\[Tau]] + r[\[Tau]]^2))/(
    a^2 Cos[\[Theta][\[Tau]]]^2 + r[\[Tau]]^2),
          pr'[\[Tau]]  == (a^4 (-a Ee + L)^2 Cos[\[Theta][\[Tau]]]^2 + 
       a^4 (L^2 Cos[\[Theta][\[Tau]]]^2 Cot[\[Theta][\[Tau]]]^2 + 
          p\[Theta][\[Tau]]^2) r[\[Tau]] + 
       a^2 (-a^2 Ee^2 + 2 a Ee L - L^2 + 
          2 a Ee (a Ee + L) Cos[\[Theta][\[Tau]]]^2 - 
          4 L^2 Cot[\[Theta][\[Tau]]]^2 - 
          4 p\[Theta][\[Tau]]^2) r[\[Tau]]^2 + (4 a^2 Ee^2 - 
          8 a Ee L + 4 L^2 - 4 a^2 Ee^2 Cos[\[Theta][\[Tau]]]^2 + 
          4 L^2 Cot[\[Theta][\[Tau]]]^2 + 
          2 a^2 L^2 Cot[\[Theta][\[Tau]]]^2 + 
          2 (2 + a^2) p\[Theta][\[Tau]]^2) r[\[Tau]]^3 + (-2 a^2 Ee^2 \
+ 6 a Ee L - 4 L^2 + a^2 Ee^2 Cos[\[Theta][\[Tau]]]^2 - 
          4 L^2 Cot[\[Theta][\[Tau]]]^2 - 
          4 p\[Theta][\[Tau]]^2) r[\[Tau]]^4 + (L^2 Csc[\[Theta][\
\[Tau]]]^2 + p\[Theta][\[Tau]]^2) r[\[Tau]]^5 - Ee^2 r[\[Tau]]^6 + 
       pr[\[Tau]]^2 (a^2 - 2 r[\[Tau]] + 
          r[\[Tau]]^2)^2 (a^2 Cos[\[Theta][\[Tau]]]^2 - r[\[Tau]]^2 + 
          a^2 r[\[Tau]] Sin[\[Theta][\[Tau]]]^2))/((a^2 Cos[\[Theta][\
\[Tau]]]^2 + r[\[Tau]]^2)^2 (a^2 - 2 r[\[Tau]] + r[\[Tau]]^2)^2),
        \[Phi]'[\[Tau]]   ==  (a^2 L Cot[\[Theta][\[Tau]]]^2 + 
       2 (a Ee - L - L Cot[\[Theta][\[Tau]]]^2) r[\[Tau]] + 
       L Csc[\[Theta][\[Tau]]]^2 r[\[Tau]]^2)/((a^2 Cos[\[Theta][\
\[Tau]]]^2 + r[\[Tau]]^2) (a^2 - 2 r[\[Tau]] + r[\[Tau]]^2)),
             \[Theta]'[\[Tau]]   ==  p\[Theta][\[Tau]]/(
    a^2 Cos[\[Theta][\[Tau]]]^2 + r[\[Tau]]^2),
           p\[Theta]'[\[Tau]]  == ((2 a^2 Cos[\[Theta][\[Tau]]] ((Ce + 
               a^2 (-1 + Ee^2) Cos[\[Theta][\[Tau]]]^2 - 
               L^2 Cot[\[Theta][\[Tau]]]^2) (a^2 - 2 r[\[Tau]] + 
               r[\[Tau]]^2) - (Ce + (-a Ee + L)^2 + 
               r[\[Tau]]^2) (a^2 - 2 r[\[Tau]] + r[\[Tau]]^2) + (a L -
               Ee (a^2 + 
                 r[\[Tau]]^2))^2) Sin[\[Theta][\[Tau]]])/(a^2 - 
          2 r[\[Tau]] + r[\[Tau]]^2) - 
       a^2 p\[Theta][\[Tau]]^2 Sin[2 \[Theta][\[Tau]]] - 
       a^2 pr[\[Tau]]^2 (a^2 - 2 r[\[Tau]] + r[\[Tau]]^2) Sin[
         2 \[Theta][\[Tau]]] + (a^2 Cos[\[Theta][\[Tau]]]^2 + 
          r[\[Tau]]^2) (2 L^2 Cot[\[Theta][\[Tau]]] + 
          2 L^2 Cot[\[Theta][\[Tau]]]^3 - 
          a^2 (-1 + Ee^2) Sin[
            2 \[Theta][\[Tau]]]))/(2 (a^2 Cos[\[Theta][\[Tau]]]^2 + 
         r[\[Tau]]^2)^2)
   };
  initialConditions =
  {
   r[0]    ==  rI,
       pr[0]   ==  0,
      \[Theta][0]   ==  \[Theta]I,
      p\[Theta][0]  ==  p\[Theta]I,
      \[Phi][0]    == 0
   };
Quiet[
  HamiltonianSolve =
    NDSolve[
             {
              dynamicEquations,
              initialConditions
               } /. {a -> aI, L -> iL},
             {r, \[Phi], \[Theta], pr, p\[Theta]},
             {\[Tau], 0, pT},
       Method -> {EventLocator, 
       "Event" -> (r[\[Tau]] - 1.02 holeSize )}
             ];
       ];
      domain      =    (r /. HamiltonianSolve[[1, 1]])["Domain"];
  {begin, end} =     domain[[1]];
  (**)
 planetHasPlunged = 
    Abs[
    (r[end] /. HamiltonianSolve)[[1]] - holeSize
     ] <= 0.05 holeSize;
     
 startPlot =
  If[
   (end - tailLength) <= 0
   ,
   0
   ,
   (end - tailLength)
    ];
 If[
  zoomManual == False,
    initialOuterRadius = ( r[end] /. HamiltonianSolve)[[1]];
    frameCantidate =
      1.05
        If[
     initialOuterRadius > rI,
      initialOuterRadius
       rI,
     ];
      frame =
   If[
    frameCantidate > frame
    ,
    frameCantidate
    ,
    frame
    ];,
  {}];
  (*
  the position of the planet 
 *)
 planetPosition =      
                    {
                     r[end] Sin[\[Theta][end]] Cos[\[Phi][end]],
                     r[end] Sin[\[Theta][end]] Sin[\[Phi][end]],
                     r[end] Cos[\[Theta][end]]
                      } /. HamiltonianSolve;
 orbitPlot =
    ParametricPlot3D[
                   { 
                r[\[Tau]] Sin[\[Theta][\[Tau]]] Cos[\[Phi][\[Tau]]],
                         r[\[Tau]] Sin[\[Theta][\[Tau]]] Sin[\[Phi][\[Tau]]],
                      r[\[Tau]] Cos[\[Theta][\[Tau]]]
                     } /. HamiltonianSolve,
                    {\[Tau], startPlot, end},
                     PlotRange ->
                               {
                                 {-frame, frame},
                                 {-frame, frame},
                                 {-frame, frame}
                               },
                     PerformanceGoal -> "Speed",
                     PlotPoints -> 200,
                     MaxRecursion -> 8,(*
                     ViewPoint\[Rule]rightViewPoint,*)
                     SphericalRegion -> True,
                 Mesh -> 4,
                 Ticks -> Automatic
                  ];
holeSize = 1 + Sqrt[ 1 - aI^2] ;
   planetSize  = 0.02 frame;
  If[
  planetHasPlunged,
  adjustedPlanetSize  = 0;,
  adjustedPlanetSize  = planetSize;
      ];
  (**)
 planetGraphic =
    Graphics3D[{Green , Sphere[ planetPosition, adjustedPlanetSize]}];
  (*
 inner boundary of the ergosphere:
 *)
 noReturnHorizon =
    Graphics3D[{Black   , Sphere[{0, 0, 0}        , holeSize  ]}];
  (*
 outer ergosphere limit: 
 *)
 outerErgosphereLimit = 
    Graphics3D[{
    Black,
    Opacity[0.2],
    Scale[
     Sphere[],
     {2, 2, holeSize},
     {0, 0, 0}
         ]}
           ];
  (*
  The orbit plot is combined with graphic elements for the hole
 ergosphere and planet.
 *)
  rightImage =
   Show[
          orbitPlot,
   noReturnHorizon, 
   outerErgosphereLimit,  
   planetGraphic,
      Graphics3D[
    Text[StringForm["energy = ``", Ee], {1.5 frame, 0, -1.1 frame}]],
      Graphics3D[
    Text[StringForm["Carter Q = ``", Chop[Ce]], {1.5 frame, 
      0, -1.3 frame}]],
       ViewPoint -> rightViewPoint,
   ImageSize -> {400, 400}
   ];
  leftImage =
   Show[
   orbitPlot,
   noReturnHorizon, 
   outerErgosphereLimit,  
   planetGraphic,
      Graphics3D[
    Text[StringForm["energy = ``", Ee], {1.5 frame, 0, -1.1 frame}]],
   
   Graphics3D[
    Text[StringForm["Carter Q = ``", Chop[Ce]], {1.5 frame, 
      0, -1.3 frame}]],
       ViewPoint -> leftViewPoint,
   ImageSize -> {400, 400}
   ],
(*
 time
 *)
 {
     {pT, tailLength, "time"}, 150, 1200,
     ImageSize -> Tiny,
  AnimationRate -> 3,
     DisplayAllSteps -> False,
  DefaultDuration -> 15,
  ControlPlacement -> Left
  }, (**)
 Delimiter, (*
 spin
 *)
 {
  {aI, 0.99, "spin rate"}, 0, 0.99, .01,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  ControlPlacement -> Left
  }, (**)
 Delimiter,
  (**)
 {
  {rI, 4, "radius"}, 2.1, 30, .01,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  ControlPlacement -> Left
  }, (**)
 {
  {iL, 2, "L"}, -4.5, 4.5, .01,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  ControlPlacement -> Left
  }, (**)
 {
  {\[Theta]I, \[Pi]/3, Subscript["\[Theta]", "I"]}, \[Pi]/7, 
  6 \[Pi]/7, \[Pi]/210,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  ControlPlacement -> Left
  },
{  {p\[Theta]I, 0.76, Subscript["p", Subscript["\[Theta]", "I"]]}, -3, 
  3, .01,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  ControlPlacement -> Left
  },
   (**)
 Delimiter,
   {
  {tailLength, 1200, "tail"}, 150, 1500,
  ControlPlacement -> Left,
  ImageSize -> Tiny
  },
 (**)
 {
  {frame, 4.5, "zoom"}, 2.5, 100, .01,
  Appearance -> "Labeled",
  ImageSize -> Tiny,
  Enabled -> zoomManual,
  ControlPlacement -> Left
  },
  (**)
 {
  {zoomManual, False, ""},
  {False -> "auto", True -> "manual"},
  ControlType -> RadioButton,
  ControlPlacement -> Left
  },
    (**)
 Delimiter,
{
  {slidersEnabled, True, ""},
  {False -> "orbit preset"},
  ControlType -> Setter,
  ImageSize -> Tiny,
  ControlPlacement -> Left
  },
  {{presetValues, {1200,   0.99, 4, 2, \[Pi]/3, 0.767851, 4.5, 1200, 
    False}, ""},
  {
   {300,   0.9, 4, 2.148, 1.037, 0, 4.2, 350, False} -> 
    Style["closed orbit                      ", 10] ,
   {1200,   0.99, 4, 2, \[Pi]/3, 0.767851, 4.5, 1200, False} -> 
    Style["constant radius orbit             ", 10] ,
   {150,   0.0, 10, 3.5, \[Pi]/2, 0, 4.5, 350, False} -> 
    Style["spiral capture orbit              ", 10] ,
   {150,   0.0,   4,     3.99999, \[Pi]/2, 0, 4.5, 350, False} -> 
    Style["unstable circular orbit capture   ", 10] ,
   {100,   0.0,   4,     4.00001, \[Pi]/2, 0, 4.5, 350, False} -> 
    Style[ "unstable circular orbit escape   ", 10] ,
   {330, 0.99,  25, 2.427, \[Pi]/2, 0, 25, 330, False} -> 
    Style[ "equatorial (1,1,1) zoom and whirl orbit"] ,
   {150,  0.9,     4,      - 4.5, \[Pi]/2, 0, 4.2, 350, False} -> 
    Style["orbit reverse and capture        ", 10],
   {150,  0.99,     10,   1.05769, \[Pi]/2, 2.89, 4, 150, True} -> 
    Style["3D zoom and whirl orbit         ", 10]
   },
  ControlType -> PopupMenu,
  ControlPlacement -> Left,
  ImageSize -> Small
  },
  (*
  blank line
  *)
 Style[
  "",
  Bold, Small
      ],
   (**)
  SynchronousUpdating -> False,
  SaveDefinitions -> True,
  TrackedSymbols -> Manipulate,
  AutorunSequencing -> {1, 2, 3, 4, 6, 7}]
[bookmark: _Toc512793715]Appendix E – 2D Black Hole
point1[m1_] := Module[{a}, a = m1; a/100];
Manipulate[
 Module[{trajectoryplot, blackhole1},
  sol[m1_, pt1_] := 
   Quiet[NDSolve[{x'[t] == 
       ux[t]/(1 + m1/Sqrt[(x[t] - pt1[[1]])^2 + (y[t] - pt1[[2]])^2]),
            y'[t] == 
       uy[t]/(1 + m1/Sqrt[(x[t] - pt1[[1]])^2 + (y[t] - pt1[[2]])^2] ),
            ux'[
        t] == ((1 + 
             2 (ux[t]^2 + 
                uy[t]^2))* (-((m1 (x[t] - pt1[[1]]))/((x[t] - 
                   pt1[[1]])^2 + (-pt1[[2]] + y[t])^2)^(3/2))) - 
                       ux[t]*(ux[
               t] (-((m1 (-pt1[[1]] + x[t]))/((-pt1[[1]] + 
                    x[t])^2 + (-pt1[[2]] + y[t])^2)^(3/2))) +
               	 uy[t] (-((m1 (-pt1[[2]] + y[t]))/((-pt1[[1]] + 
                    x[t])^2 + (-pt1[[2]] + y[t])^2)^(3/2)))))/ ((1 + 
            m1/Sqrt[(x[t] - pt1[[1]])^2 + (y[t] - pt1[[2]])^2])^2),
            uy'[
        t] == ((1 + 
             2 (ux[t]^2 + 
                uy[t]^2))* (-((m1 (-pt1[[2]] + y[t]))/((-pt1[[1]] + 
                   x[t])^2 + (-pt1[[2]] + y[t])^2)^(3/2))) - 
                ux[t]*(ux[
               t] (-((m1 (-pt1[[1]] + x[t]))/((-pt1[[1]] + 
                    x[t])^2 + (-pt1[[2]] + y[t])^2)^(3/2))) +
                         uy[t] (-((m1 (-pt1[[2]] + y[t]))/((-pt1[[1]] + 
                    x[t])^2 + (-pt1[[2]] + y[t])^2)^(3/2)))))/ ((1 + 
            m1/Sqrt[(x[t] - pt1[[1]])^2 + (y[t] - pt1[[2]])^2])^2),
      
      x[0] == xi, y[0] == yi , ux[0] == ux0, uy[0] == uy0}, {x[t], 
      y[t], ux[t], uy[t]}, {t, 0, 200}, 
     "ExtrapolationHandler" -> {Indeterminate &}]];
   trajectoryplot = 
   ParametricPlot[Evaluate[{x[t], y[t]} /. sol[m1, pt1]], {t, 0, 200},
      PlotStyle -> {{Hue[color], Dashed, Thickness[0.01]}}] /. 
    Line[x_] :> {Arrowheads[{0.04, 0}], Arrow[x]};
  blackhole1 = 
   Graphics[{ Opacity[.7], Black, PointSize[point1[m1]], Point[pt1]}];
    Show[backgroundPlot[pt1, pt2, check], trajectoryplot, blackhole1, 
   blackhole2, PlotRange -> {{-8, 8}, {-8, 8}}]],
 {{xi, 0, Row[{"initial ", Style["x", Italic], " position"}]}, -8, 
  8, .1, ImageSize -> Tiny, Appearance -> "Labeled"},
 {{yi, 0, Row[{"initial ", Style["y", Italic], " position"}]}, -8, 
  8, .1, ImageSize -> Tiny, Appearance -> "Labeled"}, Delimiter, 
 {{ux0, 0, Row[{"initial ", Style["x", Italic], " momentum"}]}, -10, 
  10, .1, ImageSize -> Tiny, Appearance -> "Labeled"},
 {{uy0, 0, Row[{"initial ", Style["y", Italic], " momentum"}]}, -10, 
  10, .1, ImageSize -> Tiny, Appearance -> "Labeled"}, Delimiter,
 {{m1, 1, "mass black hole 1"}, 1, 10, 1, ImageSize -> Large, 
  Appearance -> "Labeled"},
 Delimiter,
 Style["location of black holes"],
 {{pt1, {0, 1}, "black hole 1"}, {-8, -8}, {8, 8}, ImageSize -> Small},
  Delimiter,
 {{check, False, "show density plot?"}, {True, False}},
 {{color, .5, "trajectory color"}, .01, 1, ImageSize -> Tiny},
 SynchronousUpdating -> False,
 SaveDefinitions -> True, 
 TrackedSymbols :> {xi, yi, Delimiter, ux0, uy0, Delimiter, m1, m2, 
   Delimiter, pt1, pt2, check, color}
 ]
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When a massive spinning body become black hole, it keep spinning. As Big Bang suggests after 13.2 billion years of initial event galaxies were formed. The different mass were combined and formed the galaxy, the galaxy was formed due to presence of very high gravitational force efficient enough to bond billions of star systems. As observed and calculated it came up, that the galaxy is centred by Massive black hole spinning in the galactic centre.
The black hole which precisely define the galactic black hole id Kerr-Newman Black hole. The difference between the Kerr Black hole and Kerr Newman Black hole is that they have charged particles in them which makes there simulation difficult. So In order to study the effect of the black hole on their host galaxies. We simulated the Kerr Black hole and studied its effect, excluding the charged particles effect.
For the study of the Kerr Black hole we needed to a modified classical mechanics. We used Hamiltonian Mechanics

	Lagrangian and Hamiltonian Mechanics

	According to Newton's laws, the incremental work dW done by a force f on a particle moving an incremental distance dx, dy, dz in 3-dimensional space is given by the dot product

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image001.gif]

	Now suppose the particle is constrained in such a way that its position has only two degrees of freedom. In other words, there are two generalized position coordinates X and Y such that the position coordinates x, y, and z of the particle are each strictly functions of these two generalized coordinates. We can then define a generalized force F with the components FX and FY such that

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image002.gif]

	The total differentials of x, y, and z are then given by

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image003.gif]

	Substituting these differentials into (1) and collecting terms by dX and dY, we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image004.gif]

	Comparing this with (2), we see that the generalized force components are given by

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image005.gif]

	Now, according to Newton's second law of motion, the individual components of force for a particle of mass m are

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image006.gif]

	Substituting into the expression for FX gives

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image007.gif]

	and similarly for FY.  Notice that the first product on the right side can be expanded as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image008.gif]

	and similarly for the other two products. Since x and X are both strictly functions of t, it follows that partial differentiation with respect to t is the same as total differentiation, and so the order of differentiation in the right-most term of (4) can be reversed (because partial differentiation is commutative). Hence (4) can be written as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image009.gif]

	Substituting this (and the corresponding expressions for the other two products) into equation (3), we get

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image010.gif]

	Variations in x,y,z and X at constant t are independent of t (since each of these variables is strictly a function of t), so we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image011.gif]

	Making these substitutions into (5) gives

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image012.gif]

	Each term now contains an expression of the form r(r/s), which can also be written as (r2/2)/s, so the overall expression can be re-written as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image013.gif]

	The quantity inside the square brackets is simply the kinetic energy, conventionally denoted by T. Thus the generalized force FX, and similarly the generalized force FY, can be expressed as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image014.gif]

	These are the Euler-Lagrange equations of motion, which are equivalent to Newton's laws of motion.  (Notice that if X is identified with x in equation (5), then FX reduces to Newton's expression for fx, and likewise for the other components.)

	 

	If the total energy is conserved, then the work done on the particle must be converted to potential energy, conventionally denoted by V, which must be purely a function of the spatial coordinates x,y,z, or equivalently a function of the generalized configuration coordinates X,Y, and possibly the derivatives of these coordinates, but independent of the time t. (The independence of the Lagrangian with respect to the time coordinate for a process in which energy is conserved is an example of Noether's theorem, which asserts that any conserved quantity, such as energy, corresponds to a symmetry, i.e., the independence of a system with respect to a particular variable, such as time.) If the potential depends on the derivatives of the position coordinates it is said to be a velocity-dependent potential, as discussed in the note on Gerber’s Gravity. However, most potentials depend only on the position coordinates and not on their derivatives. In that case we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image015.gif]

	Comparing this with equation (2), we see that

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image016.gif]

	and therefore the Euler-Lagrange equations (6) for conservative systems can be written as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image017.gif]

	Rearranging terms, we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image018.gif]

	Furthermore, since V is purely a function of the configuration variables, independent of their rates of change, we can just as well substitute (TV) in place of T on the right sides of these equations, so in terms of the parameter L = T  V these equations can be written simply as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image019.gif]

	The quantity L is called the Lagrangian. This derivation was carried out for a single particle moving with two degrees of freedom in three-dimensional space, but the same derivation can be applied to collections of any number of particles. For a set of N particles there are 3N configuration coordinates, but the degrees of freedom will often be much less, especially if the particles form rigid bodies. Letting q1, q2, .., qn denote a set of generalized configuration coordinates for a conservative physical system with n degrees of freedom, the equations of motion of the system are

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image020.gif]

	Where L is the Lagrangian of the system, i.e., the difference between the kinetic and the potential energies, expressed in terms of the generalized coordinates and their time derivatives. These equations are usually credited jointly to Euler along with Lagrange, because although Lagrange was the first to formulate them specifically as the equations of motion, they were previously derived by Euler as the conditions under which a point passes from one specified place and time to another in such a way that the integral of a given function L with respect to time is stationary. (Roughly speaking, "stationary" means that the value of the integral does not change for incremental variations in the path.) This is a fundamental result in the calculus of variations, and can be applied to fairly arbitrary functions L (i.e., not necessarily the Lagrangian). For a derivation of the Euler conditions.

	To illustrate the application of these equations, consider a simple mass-spring system, consisting of a particle of mass m on the x axis attached to the end of a massless spring with spring constant k and null point at x = 0.  For any position x, the spring exerts a force equal to F = kx, and the potential energy is the integral of force with respect to displacement. Similarly the kinetic energy is the integral of the inertial force F = ma with respect to displacement. Thus the kinetic and potential energies of the system are

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image021.gif]

	Therefore the Lagrangian of the system is

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image022.gif]

	The partial derivatives are

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image023.gif]

	Substituting into Lagrange's equation, we get the familiar equation of harmonic motion for a mass-spring system

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image024.gif]

	Of course, this simply expresses Newton's second law, F = ma, for the particle.  It's also equivalent to the fact that the total energy E = T + V is constant, as can be seen by differentiating E with respect to t and then dividing through by dx/dt. 

	The equivalence between the Lagrangian equation of motion (for conservative systems) and the conservation of energy is a general consequence of the fact that the kinetic energy of a particle is strictly proportional to the square of the particle's velocity. Of course, in terms of the generalized parameters, it's possible for the kinetic energy to be a function of both q and [image: http://www.mathpages.com/home/kmath523/kmath523_files/image025.gif] but since the transformation dx = (x/q)dq between x and q is equivalent to dx/dt = (x/q)dq/dt, it follows that for a fixed configuration the kinetic energy is proportional to the squares of the generalized velocity parameters. Therefore, in general, we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image026.gif]

	where we've made use of the fact that the potential energy V (for conservative systems) is independent of [image: http://www.mathpages.com/home/kmath523/kmath523_files/image025.gif].  Now, the total energy is E = T + V = 2T  L, so the conservation of energy can be expressed in the form

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image027.gif]

	The two terms on the right hand side can be expanded as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image028.gif]

	Substituting into the previous equation and dividing through by [image: http://www.mathpages.com/home/kmath523/kmath523_files/image025.gif] (applying analytic continuation to remove the singularity when [image: http://www.mathpages.com/home/kmath523/kmath523_files/image025.gif] = 0), we see that the conservation of energy implies

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image029.gif]

	which is just Lagrange's equation of motion. Of course, the same derivation applies to any number of particles, and their generalized coordinates.

	The correspondence between the conservation of energy and the Lagrangian equations of motion suggests that there might be a convenient variational formulation of mechanics in terms of the total energy E = T + V (as opposed to the Lagrangian L = T  V). Notice that the partial derivative of L with respect to x' is the momentum of the particle. In general, given the Lagrangian, we can define the generalized momenta as

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image030.gif]

	(The partial of V is zero, so it's inclusion and sign in this definition is a matter of convention.) Thus to each generalized configuration coordinate qj there corresponds a generalized momenta pj. In our simple mass-spring example with the single generalized coordinate q = x, the total energy H = T + V in terms of these conjugate parameters is

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image031.gif]

	The function H(q,p) is called the Hamiltonian of the system. Taking the partial derivatives of H with respect to p and q, we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image032.gif]

	Notice that, in this example, p/m equals q' (essentially by definition, since p = mv), and kq equals -p' (by the equation of motion). In general it can be shown that, for any conservative system with generalized coordinates qj and the corresponding momenta pj, if we express the total energy H in terms of the qj and pj, then we have

	[image: http://www.mathpages.com/home/kmath523/kmath523_files/image033.gif]
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Manipulate[
  G  = 1;
  M  = 1;
  orbitEnergy = -  (1/r0)   +  (L^2)/( 2 r0^2) - L^2/r0^3;
  anOrbitSolution =
  Quiet@NDSolve[
    {
     r''[\[Tau]] == -( G M/ r[\[Tau]]^2) + (L^2/ 
         r[\[Tau]]^3) - (3 G M L^2/r[\[Tau]]^4) ,
            r[0] == r0,
            r'[0] == 0,
          \[Phi]'[\[Tau]] == L/ r[\[Tau]]^2,
          \[Phi][0] == 0,
          t'[\[Tau]] == \[Sqrt]( (r[\[Tau]]/ ( r[\[Tau]] - 2 G M )) +
                  (r'[\[Tau]]^2  r[\[Tau]]^2/( r[\[Tau]] - 2 G M )^2)  +
                   ( 
          r[\[Tau]]^3 \[Phi]'[\[Tau]]^2 / ( r[\[Tau]] - 2 G M ))   ) ,
           t[0] == 0
          },
        {r, \[Phi], t},
        {\[Tau], 0, pT}
        ];
  domain =
                                   (r /. anOrbitSolution[[1, 1]])[
   "Domain"];
  {begin, end} =
                                    domain[[1]];
 angleList = 
                                     \[Phi][end] /. anOrbitSolution ;
 If[symmetricOrbit == 0,
  windingNumber = angleList[[1]]/(2 \[Pi]);,
  windingNumber = angleList[[1]]/ \[Pi];
  ];
  timeDilation  = (t[end] /. anOrbitSolution)[[1]]/end ;
  anOrbitPlot =
  ParametricPlot[
   Evaluate[
    r[\[Tau]] {Cos[\[Phi][\[Tau]]], Sin[\[Phi][\[Tau]]]}
     /. anOrbitSolution],
   {\[Tau], begin, end},
   (*PlotPoints\[Rule]1000,*)
   AspectRatio -> 1,
   AxesOrigin -> {0, 0},
   PlotRange -> scale];
  anOrbitPlotReversed =
  ParametricPlot[
   Evaluate[
    r[\[Tau]] {Cos[\[Phi][\[Tau]]], -Sin[\[Phi][\[Tau]]]}
     /. anOrbitSolution],
   {\[Tau], begin, end},
   (*PlotPoints\[Rule]1000,*)
   AspectRatio -> 1,
   AxesOrigin -> {0, 0},
   PlotRange -> scale];  sRadius =   Graphics[Disk[{0, 0}, 2]];
  If[symmetricOrbit == 1,
    Show[   {    anOrbitPlot,    anOrbitPlotReversed,
     sRadius,
    Graphics[
     {      Inset[       ToString[        StringForm[
         "winding number  ``", windingNumber]],
       {-25, 35} scale/38],
      Inset[
       ToString[
        StringForm[
         "time dilation       ``", timeDilation]],
       {-25, 32} scale/38],
      Inset[       ToString[        StringForm[         "orbit energy \[Times] 100      ``", 100 orbitEnergy]],
       {22, 35} scale/38]
      }                    ]
    }, Ticks -> None, ImageSize -> {400, 400}],
    Show[
   {    anOrbitPlot,     sRadius,    Graphics[     {      Inset[       ToString[        StringForm[
         "winding number  ``", windingNumber]],
       {-25, 35} scale/38],
      Inset[
       ToString[        StringForm[         "time dilation       ``", timeDilation]],
       {-25, 32} scale/38],
      Inset[
       ToString[
        StringForm[
         "orbit energy \[Times] 100      ``", 100 orbitEnergy]],
       {22, 35} scale/38]
      }]
    }, Ticks -> None, ImageSize -> {400, 400}]
  ],
 {{L , 4, "angular momentum"}, 1/10, 100, ImageSize -> Tiny},
 {{r0, 31.6, "initial radius"}, 2.5, 50, ImageSize -> Tiny},
 {{pT, 4850, "proper time"}, 1, 10000, ImageSize -> Tiny},
 {{scale, 37.8, "view"}, 5, 100, ImageSize -> Tiny},
 {{symmetricOrbit, 0, "symmetric orbit"}, {0, 1}, 
  ControlType -> Checkbox},
 SynchronousUpdating -> False, ControlPlacement -> Left, 
 TrackedSymbols -> Manipulate]
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